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The Dance Magazine is a free magazine made for and made by ballroom dancers. You can read about different subjects all concerning ballroom dancing. We also give you the opportunity to put your add or messages in it. You can send them to me by e-mail.

The Dance Magazine is an edition from Fred Bolder’s Ballroom Site

Url:
http://www.xs4all.nl/~fghb/ballroom.htm or


http://move.to/stijldansen 
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fghb@xs4all.nl
You can download this magazine as a Word-file for free.

The Dance Magazine also has its own domain.
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http://www.dansblad.nl
Editors:  Fred Bolder, Miranda Harder-Jager and Petra Maas
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Make your own ballroom dance cd
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By: Fred

If you have a cd writer then you can make a nice ballroom dance cd. Below every song you can see the link where you can download the mp3 file. All the mp3 files are from http://www.mp3.com.au/ so it is legal. Of course most of the songs are not famous, but they are very nice.

1
El Amor Y La Luna
Alejandra Bajosh
Rumba
25

http://www.mp3.com.au/ALEJANDRABAJOSH/ 

2
Do It Again
L.A. Carpool
Cha Cha Cha
31

http://www.mp3.com.au/L.A.Carpool/ 

3
Bueno pa Gozar
La Big Latin Band
Salsa
50

http://www.mp3.com.au/LABIGLATINBAND/ 

4
I'd Go Crazy
Clinton Gregory
Quickstep
48

http://www.mp3.com.au/ClintonGregory/
5
Crush
The D’s 3
Slowfox
31

http://www.mp3.com.au/TheD's3/ 

6
Crazy Feet
The Bellhops
Quickstep
52

http://www.mp3.com.au/TheBellhops/ 

7
Blue Moon
Joey Sloan
Rumba
24

http://www.mp3.com.au/JOEYSLOAN/ 

8
Julie
Joey Sloan
Slow waltz
31

http://www.mp3.com.au/JOEYSLOAN/
9
Losin' My Memory
Loretta Cooper
Jive
37

http://www.mp3.com.au/LORETTACOOPER/ 

10
I Drifted In
Dan Steward
Rumba
28

http://www.mp3.com.au/DanStewart/
11
Best Supporting Actress
Dan Steward
Slow waltz
32

http://www.mp3.com.au/DanStewart/ 

12
Bein Bonita
Virtual House Band
Samba
48

http://www.mp3.com.au/VirtualHouseBand/ 

Favourite dance music

By: Miranda

A little while ago we put a request in the Dance Magazine to let us know your favourite dance music.

Unfortunately, we did not receive quit as many response as we hoped for, but the response we got was from The Netherlands and abroad. It is very funny to see that the favourite dance music is almost alike. 

Gabriël, Petra, Phil Samways, Don, Suzie, Fred, Gerard Witteman, Linda, Ivonne, Silvia Jager, Peter Rommers, Jeroen, Tessa Koster, many thanks for your response. Thanks to you this article could be made. 

Some people send me an enormous list of their favourite songs. At first I decided to use only a few of those songs,  but then I concluded that it would be fun for the reader to see what kind of music is favourite and maybe your new favourite song is also in that list! That’s why I chose to place the names of all the songs I received.

However, I did mention the most popular songs of every dance.

Slow waltz

Una fortiva lagrima (Izzy Cooper), The Godfather Theme, Hushabye mountain (cd Ballroom Magic), Lady lay down (CD Dancelife very best part 4) and When he spoke my name (Petra Berger) were definitely favourites. 

Amazing grace
Max Greger

Mull of Kintyre       
Wings

Dans met mij    
Johnny Blenco

The last waltz    
Engelbert Humperdinck

Junge komm bald wieder   
Freddy Quinn

All kinds of everything    
Dana

Tenderly 
London Starlight Orchestra

Feed the birds
Mary Poppins

You
Judith

Nocturne
Secret Garden

When he spoke my name
Petra Berger

Theme de la mer
Balls of fire

Earth song
CD Dance floor starts vol. 2

Jessie 
CD Dancelifes best: do you remember this

Sandy’s song
CD Dancelifes best: hay-fever

Come away with me
Norah Jones

Once you had gold
Enya

Pastorale
Secret Garden

Candle on the water
CD Cartoon songs for dancing

To love
CD Dance Floor stars vol. 2

Broke Away

Some people’s lives

Leningrad

Try to remember
Vio Friedmann

Take it to the limit
Eagles

Tango

Tango passion (Vio Friedmann) and music from the Phantom of the Opera are for this dance the favourite songs.

Green green grass of home    
CD Dancelife modern classics

Tanze mit mir in den morgen    
Gerhard Wendland

Sombras 
Joanna Orchestra (http://www.zyx.de/) 

CD Time for dancing-Ballroom Dance V. 10

Tango Mistirioso
Pedro Gomez

Tanguera
Musica & Poesia

Ecstasy
Geoff Love

Cambalache
dance floor stars vol.2

Agata
CD Klaus Hallen World hits

Libertango
CD Ballroom Swing

Destiny
Vio Friedmann

Tango of Roses
Alfrred Hause Orchestra

Tango-Potpourri
Hugo Strasser Orch

Quickstep

A big yes is for the song Sing Sing Sing (with a swing) (Count Basie). Many of you let me know this is your favourite. Besides this song, One more round (Vio Friedmann) and The way to your heart (Soulsister) were also mentioned several times.

Marina    
Dancelife modern classics

Ik zou je voor geen geld van de wereld willen missen    
Cecile Van Dijk

Papillon  
Nicole

Immer wieder sonntags    
Cidy & Bert

Congretulations    
Cliff Richard

Keep on smiling    
Engelbert Humperdinck

Without a Song
Frank Sinatra/Tommy Dorsey (1939)

You’re the one that I want
Grease http://www.greasemovie.com/

Swing Let's Swing
Luckey Strikes

Ze houdt gewoon van mij
Guus Meeuwis

No me voy sin Bailar
Ana Belen

Tucumari
CD Remember the best

A teenager in love
CD Remember the best

Whistle while you work
CD Dance charts step 3

Friend like me
CD Cartoon songs for dancing

Walking back to happiness
Helen Shapiro

I wrote a song

For the longest time
Vio Friedmann

Michael row the boat
CD Dancelife’s lean on me

Say you’ll be mine
Steps

Messenger of love
T-spoon

When the heartache is over
Tina Turner

Life is life
Hermes House band

Feel
Robbie Williams

Ain't it funny
Jennifer Lopez

I’m alive
Celine Dion

Where is the love
Black eyed peas

Intuition
Jewel

You can see a lot of music from Vio Friedmann; this is all from the same person (perhaps a fan?)

Slow foxtrot

The favourite song for the slow foxtrot is the Pink Panter theme. 

Banks of Ohio    
Max Greger

Als sterren aan de hemel stralen    
Frans Bauer

'n Dag uit duizend dromen              
Frans Bauer

King of the road    
CD Dancelife modern classics

I love you because    
Jim Reeves

Ganz in weiss    
Roy Black

Have you met miss Jones?
Robbie Williams (http://www.robbiewilliams.com/)

Rotkäppchen's traum
Helmut Jensen Orchester

Witchcraft
Frank Sinatra

Let there be love
Simple minds

Baby, it's cold outside
Bette Midler

Must be catchin’ 
CD Balls of fire

More (from ‘ mondo cane’ )
CD Balls of fire

Viennese waltz

The Harry Potter Theme (Hollywood Movie Strings, CD Ballroom Classics Five http://www.casa-musica.de/) and Hijo de la luna (CD Dancelife: very best part 8) are mentioned most often as favourite. 

Op de purperen hei    
Linda Lee

Aan het Noordzeestrand    
Het Regenboogtrio

Bachelor boy    
CD Dancelife modern classics

Morning has broken
Cat Stevens

Second walz 
André Rieu

Nights in White satin
Moody Blues

Que sera sera
Billy Vaughn

Golden brown
CD Dancelife: very best part 8

Mal des amores
CD Dance floor stars vol2

Ordinary day
CD Dance charts step 3

Chim-chim-cher-ee
CD Cartoon songs for dancing

Boy on a dolphin
CD Balls of fire

Viennese Waltz
Klaus Hallen


There was also someone who wrote that music from Strauss is very suitable for dancing the Viennese waltz.

Cha Cha Cha

The most popular cha-cha-cha-songs are Pata pata (Helmut Lottie of Coumba Cawlo) and Oh happy days (CD Dancelife; lean on me).

Due to the enormous list of favourite songs and diversity of these songs, you can conclude there is a lot of music available for dancing the Cha Cha Cha. 

Itsi bitsy tienie weenie bikini    
Brian Hyland

Summer night    
J. Travolta & O. Newton John

Needles and pins    
The Searchers

Monsieur Cannibale    
Sacha Distel

Wheels
Joe Loss

Denk het niet
NUHR (Niet Uit Het Raam) http://www.nuhr.net/

Can't get you out of my head
Kylie Minogue

Café latino medleu
Café latino

Dolce Vita
CD Dance floor starts vol. 2

Do you believe in love
Vio Friedmann, CD vol. 3

Rumours
Vio Friedmann, CD vol. 4

Tres deseos
CD Dance masters van het jaar

Derroche
CD Dancelife: baila latino

Let’s get loud
Jennifer Lopez

Ola Chica
Shico Sernandez

Sunshine Day
Vio Friedman

Stand by me
CD Dancelife’s lean on me

Chayanne
Guajira

Come and get my love
Becca

Just a little bit
Gina G

With my own eyes
Sash

Copacabana
Bombi

Heaven
DJ Sammy en Yanou ft Do

Chipz in black
Chipz

Uptown Girl
Westlife

Murder on the dance floor
S.E. Bextor

Rumba

Five readers chose Blessed (Elton John) as their favourite. After that Don’t know why (Norah Jones, CD Dance charts step 3), chosen by 3 readers. And after that Penelope (Doego Torres, CD Latin Boogalu), chosen by two readers, the same as Somos Tú Y Yo (Donato  Estéfano, CD CD Latin Boogalu).

Hemelsblauw    
Will Tura

Verborgen verdriet    
Wendy Van Wanten

Der kleine prinz    
Bernd Cluver

Du gehst fort    
I. Cheer en B. Brink

Fields of gold 
Sting

Lady in red 
Chris the Burgh

No matter what
Boyzone

7 seconds
Yousson N Doues & Nenah Cherry

Dream
The Everly Brothers

Nikita
Elton John

Can't stop loving you
Phil Collins

World of hurt
Ilse de Lange

Torn
Nathalie Imbruglia

Heal the pain
George Michael

I'm not given up
Gloria Estefan

Only love
W.Laird & N. Gomez

If you go
Barry & Eileen

Somewhere out there

An innocent man
Vio Friedman 

Very special love
Charlie Rich

Rhythm of the rain
CD Remember the best

Diamante
CD Dancelife: very best part part 8

Oyeme
CD Dancelife: baila latino

Si quieres
Juan Gabriel (Cosas de enamorados)

Would I lie to you
CD Dancelife’s lean on me

Thinking of you
N-sync

No Lloraré
Jessica Christina

Shape of my heart
Backstreet Boys

Somethin’ Stupid
Robbie Williams

Wicked game
Chris Isaac

Jive

Many like to dance the jive to Hit the road Jack (Ray Charles) and Only you (Jungle James, CD Café paradise)

Pretty Belinda    
Tom Herold

Mary-Lou
Clouseau (http://www.clouseau.be/)

Paradise by the Dashboard Light


Take me to your heaven
CD Dance charts step 3

Calendar girl
CD Dance floor stars Vol. 2

Maria
CD Dance floor stars Vol. 2

Cuando te vas
CD Dancelife: baila latino

Tengo un novio tantrico
CD Dancelife: caliente latino

To my father’s house
CD Dancelife: lean on me

Knock on wood
CD Dancelife: lean on me

Only the good die young
CD Dancelife’s best: do you remember this

Shake!
CD Latin boogalu

Viva la mamma
CD Klaus Hallen World hits

The Tulsa Shuffle
The Tractors


Tall Skinny mama
The Swing Cats

Right between the eyes
Vio Friedmann

Always have, always will
Ace of Base

Hafanana
Eli Goulart

Non non rien changé
Poppy’s

Samba

With a small majority Sueno Su Boca (Raúl, CD Latin boogalu) is the favourite Samba.

Ain’t it funny
Jennifer Lopez http://www.jenniferlopez.com/ 

Con tu amor
CD Latin boogalu

Krapuleo
CD Dancelife : baila latino

Kusha las payas
CD Dance charts step 3

Le serpent
Guem et Zaka (Percussion)

Que Locura
Miguel Saez

Viva El Amoro
Sammy

Que la Detengan
A. Abad

Canto Envolvente
Carrapicho

Baila Baila Comigo
Domino

Ooh La La
Chicadee

whenever wherever
Shakira

Paso Doble

Favourite is: Spanish Gipsy Dance (The Strings of Paris, CD Café paradise).

España Cañi
Luis Cobos

Something happened

Camouflage
Vio friedman vol.4

The genuine ‘rodeo’ hat dance
CD Dancelife’s best: hay-fever

Jacky
CD Dancelife’s best: do you remember this

Torero
CD Dancelife: caliente latino 

CD Dancelife: baila latino

Salsa

I’ve had the time of my life
Dirty Dancing

Tip from one of the readers: take a look at www.vitaminic.nl (it is a Dutch site, but if you use ‘zoeken’ you will find some nice Salsa-music. 

Disco-fox

Good girls
Vio Friedmann

Comic
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Ascii dancers

By: Fred

In the magazines 61 and 63 you could have seen that you can draw nice dance couples with the characters that are on your keyboard. I have made some more drawings. This time no ballroom dancers, but Highland dancers. If you have ever been to Scotland, you will probably recognize them. Draw your own dancers and send them to fghb@xs4all.nl
   \

  O/
 <|

 /_\

  |

  ^

fghb 2004
A small drawing seems easy, but one character makes a big differents. It is also difficult to make it easy to recognize.



                __

 fghb 2004      `\\

                  \\

           ___     \\

          /_-_\     \\

         | . . |    ||

          \ - /    / /

      __ __| |__ _/ /

    .'\ |  \-/  | `/

  .'.' -|  .|.  |-'

 < <    |  :|:  |

  `.`.  |  :|:  |

    `.`-|___|___|

      `./#|_|#|_\

       ||_|_|_|_||

       /|#|_|#|_|\

      |_|_|_|_|_|_|

      |_|#|_|#|_|#|

      |_|_|_|_|_|_|

         | | | |

         | | | |

         |X| |X|

         |X| |X|

         |X| |X|

         |X| |X|

         / / \ \

         -'   `-

I wanted to draw the same dancer in different sizes. On the next page you can see a big drawing with many details.

                    ________

                           `----_  \

                                 \  \

                                  \  \

                                   \  `

                                    \  `.

                                     \   .

                                      \   \

                      __----__         \   \

                     /__----__\         |   |

                    //        \\        |   |

                    || _   _  ||       |    |

                    \| @   @  |/      |     /

                     |        |      /     |

                      \  -   /     _/\    |

              _____ __ |    | __ _/   |  /

         __---     |  |\____/|  |     | /

         \_        |   \_  _/   |      \

       .'  \       |    o||o    |       \

     .'    \       |     ||     |    __/

   .'     ,-\_____/     o||o     \_.'

  /     .'        |      ||      |

 |    <           |     o||o     |

  \    `.         |      ||      |

   `.    `.       |     o||o     |
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       `.    `--' ]     o||o     \

          ` . __  ]---. /  \ .----

                `-/||| Y||||Y |||\

                 /||||__||||__||||\

                | |  |  |  |  |  | |

                |_|__|__|__|__|__|_|

                / ||||  ||||  |||| \

               /__||||__||||__||||__\

               |  |  |  |  |  |  |  |

               |__|__|__|__|__|__|__|

               |  ||||  ||||  ||||  |

               |__||||__||||__||||__|

               |  |  |  |  |  |  |  |

               |__|__|__|__|__|__|__|

               |__||||__||||__||||__|

                   |    |  |    |

                   |    |  |    |

                   |    |  |    |

                   \____/  \____/

                   | /\ |  | /\ |

                   \//\\|  |//\\/

                    \\//|  |\\//

                    |\/ |  | \/|

                    |/\ |  | /\|

                    |/\\|  |//\|

  fghb 2004         |\//|  |\\/|

                    |\//    \\/|

                   / X |    | X \

                  | X /      \ X |

                 / X |        | X \

                 \__/          \__/

Señor Coconut

By: Fred

In magazine 61 I have written about the cd Fiesta Songs of this group and as promised here is another cd. The songs on this cd are Latin versions of Kraftwerk songs. Nenon Lights is good for practising new Cha Cha Cha variations.
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El Baile Aleman

Señor Coconut

Y Su Conjunto

Price: 19,95 euro

1
Introducción
-
-

2
Showroom Dummies
Cha Cha Cha
32

3
Trans Europe Express
-
-

4
The Robots
Cha Cha Cha
29

5
Neon Lights
Cha Cha Cha
25 (slow)

6
Autobahn
-
-

7
Homecomputer
Merengue
70

8
Tour De France
Merengue
74

9
The Man Machine
Rumba
28

10
Music Non Stop
-
-

Dancing with your computer
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By: Fred

This is a regular returning column about my self-made dance software DansCAD and DcWin. This is free software which you can download from my site:

http://www.xs4all.nl/~fghb/07.htm
All important updates appear in this dance magazine. You can also download a manual from my site.

I have placed a new version of DcWin on my site with of course some new functions.

Different users

When more persons use DcWin on the same pc, you probably want to have your own configuration. For example, a lady want to see the lady's step description. If you tell DcWin who you are, your favourite settings can be loaded automatically. Choose User from the File menu. Enter your user name and password and press the Login button. A password can be an empty string. Change the settings of DcWin and choose "Save settings" from the Settings menu. A file with your personal settings will be created and the next time that you login, the last saved settings will be loaded.

Extra information

Use the Info command to save extra information with a figure. Choose Info from the File menu. There appears a window in which you can enter text. Check “Show Info if available” on the View tab of the Options dialog box (menu: Settings, Options) if you want to show the info if available when opening a figure.

Count

Choose Count from the View menu to display the count (slow, quick etc). This only works if DcWin can recognize the dance of the current figure by its file name. Press F1 and click on “File names” for more information. When printing it is also possible to print the count.

Playing speed

Choose Tempo from the Settings menu to adjust the playing speed. Of course you already know this, but by checking “Play figures at half speed” all figures will be played at half speed whereby the Tempo setting does not change. This is handy when studying figures.

If you press the Default button and DcWin recognizes the dance of the current figure, the tempo will be set to the default tempo of that dance.

Nice links

By: Fred

Dance and Technology Weblog

http://www.greatdance.com/dancetech/
Dance software etc.

Dance terms

http://www.ballroomdancers.com/Learning_Center/Glossary/
http://www.webref.org/dance/dance.htm
http://www.centralhome.com/ballroomcountry/dance_terms.htm
http://encyclopedia.thefreedictionary.com/Glossary%20of%20partner%20dance%20terms
Dianna's Dance Manual

http://home.att.net/~diannashipman/Manual.html
Descriptions of Scottish dance steps

Make dancers with beads

http://icandream.com/doll/original/dance/index.shtml
http://icandream.com/doll/original/special/19.shtml
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Merry Christmas and a Happy New Year!!



























PAGE  
16

